Instructions

Type 1Q Valve Position Monitors are designed to provide high accuracy feedback of valve position to plant control systems.
These instructions outline the requirements for ensuring a long and trouble free service life from the monitors.

Installation - Mounting

Attach mounting plate (1) to the actuator using fasteners (2) and lockwashers (2a) provided with mounting kit (if supplied by Imtex).
Loosen indicator cover set screw (3) and rotate indicator cover (4) to desired viewing angle. Retighten set screw (3).

Rotate coupling spacer (5) and indicator drum (6) to desired position (OPEN or CLOSED appearing through indicator window).

Fit torque coupler (7) or NAMUR drive block (7a) using screw (8) supplied in kit.

Fit monitor assembly to actuator ensuring that the torque coupler/NAMUR drive block (7/7a) engages the pinion of the actuator (9).
Secure the assembly using the bolts (10) and lockwashers (11) provided with the mounting kit.

Fine tune the indicator cover (4) by loosening set screw (3). Retighten set screw when completed.

Operate the actuator to ensure proper alignment between monitor and actuator. Eccentricity of the shaft must not exceed 0.25mm. If it should be
necessary, re-align monitor by loosening mount bolts (10). Retighten bolts when satisfied with alignment.

Installation - Wiring & Transmitter Setting

Once the monitor is fitted to the actuator, remove cover (12). NOTE: On flameproof enclosures, the cover lock screw (13) must be loosened
prior to cover removal.

Bring field wiring into the enclosure via the conduit entries (14) fitted with a suitable cable gland. Use blanking plugs to block off any un-used
cable entries. NOTE: Suitable IP rated glands and plugs must be used to maintain monitor IP rating. On flameproof enclosures, only certified
cable glands and blanking plugs can be used.

Connect field wiring to the terminals (15) within the enclosure according to the wiring diagram and terminal labelling. Connect earth conductor
(which forms part of the supply cable) to the internal earth point (18).

NOTE: The Type AQ/IQ Transmitter is factory set to provide position information over a 90 Degree span.

NOTE: Specific information on the method for setting the zero and span for the transmitter option supplied is detailed on the
attached Set Up Sheet.

Drive the actuator to the position intended to indicate the 'low' signal. Set the zero point for the transmitter either locally (when available)
or using suitable configuration software. Drive the actuator to the position intended to indicate the 'high' signal. Set the span point either
locally (where applicable) or using suitable configuration software.

Once completes, verify that indication is as required by fully stroking the actuator. Then refit cover (12). NOTE: On flameproof enclosures,
the cover lock screw (13) must be retightened.

SPECIAL CONDITIONS FOR FLAMEPROOF ENCLOSURES - ATEX / IECEx

Installation should be carried out by suitably trained personnel to an applicable Code of Practice (eg IEC/EN60079-14 & IEC/EN61241-14).
Only suitably certified and temperature rated cable glands and blanking plugs are permitted for use with ATEX/IECEx flameproof enclosures.

WARNING - The cable entry temperature rise is deg C above ambient - ensure use of suitably temperature rated cable & gland.
& WARNING - Electrostatic Hazard: Clean Only with a Damp Cloth.

WARNING - Do not install on an external source of heating or cooling e.g. by hot/cold air blowing temperature units

WARNING - Locate monitor to prevent propagating brush discharges

WARNING - Monitor should not be opened when energised or an explosive atmosphere may be present.
The cover screw (13) must be loosened before opening and re-tightened before the monitor re-enters service.

The maximum constructional gap (ic) is less than that required by Table 2 of IEC 60079-1:2007 clause 5.2.2 as detailed below:

Flamepath - Push Rod and Main Body :

Max Gap (mm) - 0.1 REV DRAWN DATE CHK'D ECO

Comment - Cylindrical Spigot Joint PT 15.6.09 09-1084
A 7.10.09 09-1164

Maintenance

The Type 1Q requires no servicing during normal working life, if installed correctly.
However, it is advisable to check mounting screws/bolts, o-rings and terminal wiring
for signs of loosening or corrosion as part of the routine plant maintenance to ensure
continued operation. Ensure safety warnings are observed during maintenance.
Inspection & maintenance to ATEX/IECEx flameproof enclosures to be carried out by
suitably trained personnel with applicable code of practice

(eg IEC/EN60079-17 & IEC/EN61241-17). Repairs to Type 1Q ATEX/IECEx
flameproof enclosures are not permitted. Please consult factory.

Imtex Controls Limited

Unit 5A, Valley Industries, Hadlow Road
Tonbridge, Kent, TN11 0AH. United Kingdom
Tel:+44(0)1732-850360 Fax:+44(0)1732-852133

Website: www.imtex-controls.com

Reference Diagram

N

Additional Instructions for Safe Use

The certification for this monitor relies upon the following materials used in its construction:

- Stainless Steel

- EDPM 70 or Viton V700-75 Seals (depending on operating temperatures)

If the equipment is likely to come into contact with aggressive substances, then it is the responsibility
of the user to take suitable precautions that prevent it from being adversely affected, thus ensuring
that the type of protection provided by the equipment is not compromised. Aggressive substances
might be: acidic liquids or gases that attack Stainless Steel, or direct and prolonged contact with some

Hydrocarbons that could affect the seals. Regular checks/inspections should be carried out if aggressive
substances are present.
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Wiring Diagrams and Operating Data
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MONITOR - TRANSMITTER -
AQ/IQ70

| _ |
CONDUIT

ENTRIES

AQ/IQ70 - Analogue/Digital Transmitter

Supply Voltage: 8 to 30VDC
Internal Consumption: 25mW to 0.8W

Voltage Drop: 8VDC
Warm Up Time: 5 min
Comms Link: Loop
Signal / Noise Ratio: min 60 dB

Min Response Time: 0.33 s
Calibration Temp: +20 to +28 Deg C
Op Temp Range: -40 to +60 Deg C

This private & confidential drawing is the property
of Imtex Controls Limited, Tonbridge, UK and cannot
be copied or reproduced without the express
written permission of the Company.

Referenced Standards

The following standards have been referred to in
these instructions and are applicable to the use
of this product when used in an environment
where an explosive atmosphere may be present:

IEC 60079-0:2007 5th Ed
IEC60079-1:2007 6th Ed
IEC 61241-1:2004 1st Ed
EN60079-0:2006
EN60079-1:2007
EN61241-0:2006
EN61241-1:2004

REV DRAWN DATE CHKD = ECO
PT 15.6.09 09-1084
A 7.10.09 09-1164

Imtex Controls Limited

Unit 5A, Valley Industries, Hadlow Road
Tonbridge, Kent, TN11 0AH. United Kingdom
Tel:+44(0)1732-850360 Fax:+44(0)1732-852133

Website: www.imtex-controls.com

Cable Entries

The number and type of cable entry on the Monitor can be determined by reference
to the 6th digit of the monitor part number. For example, in part number -

IQ16S5SR

the sixth digit is a '5' which corresponds to the monitor having 2 off M20 x 1.5 cable entry.

Refer to table below for details.

CABLE ENTRY GUIDE
DIGIT ENTRIES SUPPLIED

5 (2)M20x 1.5

6 (3)M20x 1.5

8 (1) 3/4" NPT (central entry)
(1) 1/2" NPT (offset entry)

9 (1) 3/4" NPT (central entry)
(2) 1/2" NPT (offset entry)

B (2) 1/2" NPT

C (3) 172" NPT

NPT Threads conform to ANSI/ASME B1.20.1 and shall be made up wrench tight
Metric Thread tolerance to ISO 965-1 and ISO 965-3
Product Markings

The label on the monitor should be as below:

TYPE IQ
Valve Position Monitor

IEC CERTIFICATE NO: IECEx SIR 08.0099X
ATEX CERTIFICATE NO: SIRA 08ATEX 1266X

‘ModdQ ‘Serial:

MAX PERMISSIBLE POWER DISSIPATION WITHIN ENCLOSURE:

WATTS

@IIZGD o

Exd IIC T6 Tamb = -40°C to +40"C Gb & Ex tb IIC T85*C Db IP6X

Exd IIC T6 Tamb = -40°C to +60°C Gb & Ex tb IlIC T85°C Db IP6X
Exd IC T4 Tamb = -15C to +80°C Gb & Ex tb IlIC T135°C Db IP6X
WARNING: THE CABLE ENTRY TEMP. RISE IS °C ABOVE AMBIENT AT
MAX POWER. ENSURE USE OF SUITABLY RATED CABLE & GLAND

'WARNING: DO NOT OPEN WHEN ENERGISED OR WHEN AN
EXPLOSIVE ATMOSPHERE MAY BE PRESENT.
AWarning: Electrostatic Hazard - Clean Only with’'Damp Cloth
Amtexcontrols
L CURKURIGATING WITH vALYES
Tonbridge - TN11 0AH - UK

www.imtex-controls.com
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Programming:
PRetop 5335 can be configured in the following 3 ways:

1 With communications interface Loop Link 5905 or 5909 and
PReset PC configuration software.

2. With a HART® modem and PReset PC configuration software.

3. With a HART® communicator with PR DDL driver.

1: Loop Link 5905A:

For programming please refer to the drawing below and the help functions in

PReset.

Loop Link 5905A is not approved for communication with modules installed in

hazardous (Ex) areas.
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Ref: PRetop Set-up Procedure i’ t

Date: Feb 2009 MONITORING o (ONTROL
Tonbridge - UK

Tel: +44 (0)1732-850360
Fax: +44 (0)1732-852133
Email: sales@imtex-controls.com

PRetop Module (5333 or 5335 HART) Standard Set-up Configuration.

The PRetop transmitter is normally configured using the type 5905 Loop Link configuration Interface and the PReset configuration
software (Available on request) via a standard PC.

As standard the AQ/IQ Transmitter is fitted with a 10k? potentiometer with or without rotation stops. (Other potentiometer values are
available on request.) The input range of the PRetop transmitter is O - 10k?. The minimum input span is 307?.

Once the PReset software has been loaded onto the PC, Connect the Looplink 5909 interface unit to the positive(+) and Negative (9
terminals of the transmitter unit using the cables provided. (Depending on the model of the transmitter unit, this may be via a terminal
block or directly to the PRetop Module.)

Each Transmitter Assembly leaves the factory with an initial calibration setup, this information is stored within the PRetop transmitter
module and contains data such as input and output type, and manufacturers serial number. It is recommended that before
proceedingw ith re-calibration, this initial data is downloaded to the PC and saved. This will enable the user to revert to factory
settings should this be necessary. To do this, use the following procedure:

From the “Tool s” dropdown menu select the “Receiw’ option (or alternatively use Ctrl+Ron the keyboard).
2. When the Calibration data has downloaded successfully, select “ X' to close the dialogue box.
3. From the “RI€ dropdown menu, select “Save” (or alternatively use Ctrl+S on the keyboard).

Alternatively, to configure the transmitter from scratch, use the following procedure:

1. From the left hand side of the PReset Software screen, select the transmitter type that corresponds to the unit being calibrated,
eg: “ PRet op 5333”

2. Onthe Input tab, from the “Type” dropdown menu select “ RTD Elements’ and under General section, select “Li near Resi stor”.

3. On the Output tab, from the “Type” dropdown menu select “Current” and under the General section, select the output required.
For example, for a clockwise to close actuator w here 4mA corresponds to the CLOSED position and 20mA to the OPEN
position, it is necessary to select “20...4mA” where 0% = 20mA and 100% = 4mA.

4.  From the “Limits” and “Sensor Error Action” dropdown menus, select the required options. (The factory default fa these settings
is Limits = Mixand Sensor Eror Action=0f)

To perform the travel calibration it is necessary to enter the input resistance values from the potentiometer corresponding to the
travel limits of the actuator, the following procedure describes calibration of a Clockwise to Close actuator:

Note: To ensure accurate and trouble free calibration, it is suggested that the initial values be at least 10007 outside of the actual
resistance range being used.

1. DISCONNECT the Looplink 5909 interface unit before making the resistance measurements .

2. Connect a resistance meter between the BLUE and YELLOW wires on the potentiometer.

3.  Drive the Actuator to the fully CLOSED position and note the measured resistance, (eg: 5638?) Drive the Actuator to the fully
OPEN position ensuring that the Resistance value DECREASES smoothly throughout the stroke and that at no point does it
read “Open Circuit‘. Note the measured resistance at the “OPEN" position (eg: 29347)

4. Subtract 1000 from the OPEN value (eg: 2934 - 1000 = 19347?) and enter this figure into the 0% box in the “I nput Resi st ance’
section on the Input tab.

5. Add 1000 to the CLOSED value (eg: 5638 + 1000 = 66387?) and enter this figure into the 100% box in the “I nput Resi st ance”
section on the Input tab.

6. RE-CONNECT the Looplink 5909 interface unit.

7. From the “Tool s” dropdown menu select the “Transmit” option (or alternatively use Ctrl +T on the keyboard). And select” Yes” to
overwrite the device configuration, when the Calibration data has been transmitted successfully, select* K’ to close the
dialogue box.

8. From the “View " dropdown menu select the “Monita™ option.

9.  When the monitor setup has loaded, drive the actuator to the fully CLOSED position. From the Device Values section of the
monitor screen, note the “Input:” value at the top of the list, eg: 5625?. (Note: Thisistheactua resistanceinOnsthat the
PRet o p Modul ei s readi ng fromt he potenti onet er and may differ fram t he neasur ed val ue)

10. Drive the actuator to the fully OPEN position and note the “Input:” value again eg: 29307? .

11. From the “View " dropdown menu select the “ Tabbed” option.

12.  When the Device setup screen has re-loaded, in the “I nput Resi stance” section on the Input tab. enter the new OPEN value
(29307?) into the 0% box and the new CLOSED value (56257 into the 100% box.

13. From the “Tools” dropdown menu select the “Transmit” option (or alternatively use Ctrl+T on the keyboard). And select“Yes” to
overwrite the device configuration, when the Calibration data has been transmitted successfully, select “OK” to close the
dialogue box.

14. From the “View” dropdown menu select the “Monita” option.

15. When the monitor setup has loaded, drive the actuator to the OPEN and CLOSED positions and ensure that the 4 to 20mA
Output is working correctly.

16. Finally, return once again to the Device setup screen and from the the “RI€’ dropdown menu, select “ Save” (or alternatively
use Ctrl+Son the keyboard). And Save the device configuration for future use.

Note: PRetop 5335 HART Module can also be configured using an Approved HART modem and PReset PC configuration software
or HART c ommunicator with PR DDL driver.

Imtex Monitoring & Control is a trading name of IMTEX Controls Limited




Instructions

Type 1Q Valve Position Monitors are designed to provide high accuracy feedback of valve position to plant control systems.
These instructions outline the requirements for ensuring a long and trouble free service life from the monitors.

Installation - Mounting

Attach mounting plate (1) to the actuator using fasteners (2) and lockwashers (2a) provided with mounting kit (if supplied by Imtex).
Loosen indicator cover set screw (3) and rotate indicator cover (4) to desired viewing angle. Retighten set screw (3).

Rotate coupling spacer (5) and indicator drum (6) to desired position (OPEN or CLOSED appearing through indicator window).

Fit torque coupler (7) or NAMUR drive block (7a) using screw (8) supplied in kit.

Fit monitor assembly to actuator ensuring that the torque coupler/NAMUR drive block (7/7a) engages the pinion of the actuator (9).
Secure the assembly using the bolts (10) and lockwashers (11) provided with the mounting kit.

Fine tune the indicator cover (4) by loosening set screw (3). Retighten set screw when completed.

Operate the actuator to ensure proper alignment between monitor and actuator. Eccentricity of the shaft must not exceed 0.25mm. If it should be
necessary, re-align monitor by loosening mount bolts (10). Retighten bolts when satisfied with alignment.

Installation - Wiring & Switch Setting

Once the monitor is fitted to the actuator, remove cover (12). NOTE: On flameproof enclosures, the cover lock screw (13) must be loosened
prior to cover removal.

Bring field wiring into the enclosure via the conduit entries (14) fitted with a suitable cable gland. Use blanking plugs to block off any un-used
cable entries. NOTE: Suitable IP rated glands and plugs must be used to maintain monitor IP rating. On flameproof enclosures, only certified
cable glands and blanking plugs can be used.

Connect field wiring to the terminals (15) within the enclosure according to the wiring diagram and terminal labelling. Connect earth conductor
(which forms part of the supply cable) to the internal earth point (18).

Drive the actuator to the first required indication position and set the bottom switch by lifting and rotating the bottom cam (16). Secure the
cam by allowing it to fully re-engage with the spline (17).

Repeat the process for each switch in-turn by lifting/pushing down the appropriate cam, rotating and re-engaging when desired position is reached

Once completed, verify that indication is required by fully stroking the actuator. Then refit cover (12). NOTE: On flameproof enclosures, the
cover lock screw (13) must be retightened.

SPECIAL CONDITIONS FOR FLAMEPROOF ENCLOSURES - ATEX / IECEx

Installation should be carried out by suitably trained personnel to an applicable Code of Practice (eg IEC/EN60079-14 & IEC/EN61241-14).
Only suitably certified and temperature rated cable glands and blanking plugs are permitted for use with ATEX/IECEx flameproof enclosures.
WARNING - The cable entry temperature rise is deg C above ambient - ensure use of suitably temperature rated cable & gland.

& WARNING - Electrostatic Hazard: Clean Only with a Damp Cloth.

WARNING - Do not install on an external source of heating or cooling e.g. by hot/cold air blowing temperature units

WARNING - Locate monitor to prevent propagating brush discharges

WARNING - Monitor should not be opened when energised or an explosive atmosphere may be present.
The cover screw (13) must be loosened before opening and re-tightened before the monitor re-enters service.

The maximum constructional gap (i) is less than that required by Table 2 of IEC 60079-1:2007 clause 5.2.2 as detailed below:

Flamepath - Push Rod and Main Body

Max Gap (mm) - 0.1

Comment - Cylindrical Spigot Joint REV DRAWN DATE CHK'D ECO
Maintenance PT 15.6.09 09-1084

The Type 1Q requires no servicing during normal working life, if installed correctly.
However, it is advisable to check mounting screws/bolts, o-rings and terminal wiring
for signs of loosening or corrosion as part of the routine plant maintenance to ensure
continued operation. Ensure safety warnings are observed during maintenance.
Inspection & maintenance to ATEX/IECEx flameproof enclosures to be carried out by
suitably trained personnel with applicable code of practice

(eg IEC/EN60079-17 & IEC/EN61241-17). Repairs to Type IQ ATEX/IECEx
flameproof enclosures are not permitted. Please consult factory.

Imtex Conftrols Limited

Unit 5A, Valley Industries, Hadlow Road
Tonbridge, Kent, TN11 0AH. United Kingdom
Tel:+44(0)1732-850360 Fax:+44(0)1732-852133

Website: www.imtex-controls.com

Reference Diagram
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Additional Instructions for Safe Use

The certification for this monitor relies upon the following materials used in its construction:

- Stainless Steel

- EDPM 70 or Viton V700-75 Seals (depending on operating temperatures)

If the equipment is likely to come into contact with aggressive substances, then it is the responsibility
of the user to take suitable precautions that prevent it from being adversely affected, thus ensuring
that the type of protection provided by the equipment is not compromised. Aggressive substances
might be: acidic liquids or gases that attack Stainless Steel, or direct and prolonged contact with some

Hydrocarbons that could affect the seals. Regular checks/inspections should be carried out if aggressive
substances are present.
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Wiring Diagrams and Operating Data
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AQ/IQ42 & 52 - NAMUR Proximity Sensor

Current Ratings: Target Present - Current < 1.0mA
Target Absent - Current > 3.0mA

Voltage Range: 5 to 25VDC (nominal 8VDC)

Temp Range: -25to +72 Deg C

Operating Life: ~ Unlimited Cycles

Use with intrinsically safe repeater barrier. Namur
sensors fully conform to EN60947-5-6 (VDE0660
Part 212) standard.

This private & confidential drawing is the property
of Imtex Controls Limited, Tonbridge, UK and cannot
be copied or reproduced without the express
written permission of the Company.

Referenced Standards

The following standards have been referred to in
these instructions and are applicable to the use
of this product when used in an environment
where an explosive atmosphere may be present:

IEC 60079-0:2007 5th Ed
IEC60079-1:2007 6th Ed
IEC 61241-1:2004 1st Ed
EN60079-0:2006
EN60079-1:2007
EN61241-0:2006
EN61241-1:2004

REV DRAWN DATE CHKD = ECO
PT 15.6.09 09-1084

Imtex Conftrols Limited

Unit 5A, Valley Industries, Hadlow Road
Tonbridge, Kent, TN11 0AH. United Kingdom
Tel:+44(0)1732-850360 Fax:+44(0)1732-852133

Website: www.imtex-controls.com

Cable Entries

The number and type of cable entry on the Monitor can be determined by reference
to the 6th digit of the monitor part number. For example, in part number -

IQ16S5SR

the sixth digit is a '5' which corresponds to the monitor having 2 off M20 x 1.5 cable entry.
Refer to table below for details.

CABLE ENTRY GUIDE
DIGIT ENTRIES SUPPLIED

5 (2)M20x 1.5

6 (3)M20x 1.5

8 (1) 3/4" NPT (central entry)
(1) 1/2" NPT (offset entry)

9 (1) 3/4" NPT (central entry)
(2) 1/2" NPT (offset entry)

B (2) 1/2" NPT

C (3) 172" NPT

NPT Threads conform to ANSI/ASME B1.20.1 and shall be made up wrench tight
Metric Thread tolerance to ISO 965-1 and ISO 965-3
Product Markings

The label on the monitor should be as below:

—
=

TYPE IQ
Valve Position Monitor

IEC CERTIFICATE NO: IECEx SIR 08.0099X
ATEX CERTIFICATE NO: SIRA 08ATEX 1266X

‘ModdQ ‘Serial:

MAX PERMISSIBLE POWER DISSIPATION WITHIN ENCLOSURE:

& e
O

Exd IIC T6 Tamb = -40°C to +40"C Gb & Ex tb IIC T85*C Db IP6X

Exd IIC T6 Tamb = -40°C to +60°C Gb & Ex tb IlIC T85°C Db IP6X

Exd IC T4 Tamb = -15C to +80°C Gb & Ex tb IlIC T135°C Db IP6X

WARNING: THE CABLE ENTRY TEMP. RISE IS °C ABOVE AMBIENT AT

MAX POWER. ENSURE USE OF SUITABLY RATED CABLE & GLAND

'WARNING: DO NOT OPEN WHEN ENERGISED OR WHEN AN
EXPLOSIVE ATMOSPHERE MAY BE PRESENT.

AWarning: Electrostatic Hazard - Clean Only with’'Damp Cloth
Amtexcontrols

L CURKURIGATING WITH vALYES
Tonbridge - TN11 0AH - UK

www.imtex-controls.com
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